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Introduction 

The U.S. Environmental Protection Agency’s (EPA’s) Assessment Database (ADB) 
software was developed as a tool for State environmental agencies to ease the burden of State 
reporting of water quality assessment data. The EPA supported the development and distribution 
of the ADB software to encourage standardization of reporting between sates and facilitate the 
generation of the National Assessment Database and the biennial National Water Quality 
Inventory. The main function of the Assessment Database version 2 (ADBv2) is to store 
assessment information in a way that is consistent with EPA’s Guidance for 2008 Assessment, 
Listing and Reporting Requirements Pursuant to Sections 303(d) and 305(b) of the Clean Water 
Act (EPA 2006); henceforth referred to as the Guidance, which is available at: 
http://www.epa.gov/owow/tmdl/2008_ir_memorandum.html. In the Guidance, EPA encouraged 
states to integrate the reporting requirements under Sections 305(b) and 303(d) of the Clean 
Water Act (CWA). ADBv2 is designed to facilitate the integration of the two programs and 
produce attainment category reports, as defined by the Guidance, based on the assessment 
information in the database. 

System Overview 

The ADBv2 is a relational database application based on either an Oracle, Microsoft 
(MS) Access, or SQL Server database with a Visual Basic user interface. The ADB includes two 
files: a user interface file and a database file. The user interface file must be installed locally on 
each user’s machine. This file contains all of the graphical screens and tools that allow the user to 
enter and view data. The second file is a database file that stores all of the data. This file may be 
stored on an individual machine or on a server for access by multiple users. An advantage of this 
two-file design is that the graphical interface can be improved without affecting the table 
structure or data stored in the database file. 

The user interface of the MS Access and SQL Server versions of the ADB are virtually 
the same as the Oracle version, which was originally used to develop the ADBv2; however, 
choosing to use the MS Access version does not allow the user to take advantage of the power of 
the Oracle database. MS Access ADBv2 users will sacrifice (1) a more secure data storage 
environment and the ability to create user profiles with specific data privileges, (2) the ability to 
restore lost or corrupted data and significantly lower incidents of database corruption, (3) data 
back-up features, (4) increased data storage capacity (e.g., the Oracle version of ADBv2 can store 
data that could easily exceed the 2 gigabyte storage capacity in MS Access), and (5) Web 
servability. Using the SQL Server version does not have the disadvantages of using the MS 
Access version. 
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Getting Started 

Installing the ADB 

For detailed instructions on installing the ADB, see Appendix A of the ADB User’s 
Guide, available from the “Reference” section at www.epa.gov/waters/adb. There are two parts 
to the installation of the ADB: installing the user interface, such as data entry and viewing forms, 
and the database, or the actual data tables. You may want to have your database administrator 
(DBA) handle the database installation for you.  

If you use the Oracle or SQL Server version of ADBv2, your DBA can also set up users 
for the ADB. There are two types of ADB users: administrators and users. Personnel who have 
been assigned the administrator role can add, delete, and modify data. Personnel who have been 
assigned a user role can only view data. The Oracle version of ADBv2 comes with a default user 
called ADBUSER (this is also the password). ADBUSER has administrative privileges, so all of 
your assessment data may be entered using this login. You can also have your DBA remove 
ADBUSER if database security is a concern. For the SQL Server version, users’ roles must be set 
up before data can be entered or viewed via the user interface. User-level security is not available 
if you use the MS Access version of ADBv2. 

Starting the ADB 

Microsoft Access 

After installing the ADB Interface, you will have a new item on your Start->Programs 
menu in Windows called ADBv2 for Access. Select ADBv2 from this menu to start the 
application. You will be prompted to navigate to the ADBaccess.mdb database if you see the 
following message: 

Oracle 

After installing the ADB Interface, you will have a new item on your Start->Programs 
menu in Windows called ADBv2 for Oracle. Select ADBv2 from this menu to start the 
application. You will be prompted to enter the database name, a user name, and password. Use 
the default settings, which are shown below, or check with your Oracle DBA for the appropriate 
entries for this dialog. 
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Database Name: 
User name: 
Password: 

ADB 
ADBUSER 
ADBUSER 

Default settings for accessing ADBv2 

SQL Server 

After installing the ADB Interface, you will have a new item on your Start->Programs 
menu in Windows called ADBv2 for SQL Server. Select ADBv2 from this menu to start the 
application. In the “Connect to Database” dialog box, you will have to enter the name of the 
server that has the SQL Server database. Next, specify a security option. There will be two 
security choices: Windows NT security or user-level security. If you use NT security, you do not 
need to enter a user name and password. Before you can use the ADB, you will need to be set up 
as a user and assigned an ADB User role. Once you enter this information, the ADB will record 
your entries (except for the password) to speed up your login to the ADB. Use the default 
settings, which are shown below, or check with your SQL Server DBA for the appropriate entries 
for this dialog. User-level security requires you to enter a password. 

Database Name: 
User name: 
Password: 

ADB 
ADBUSER 
ADBUSER 

Default settings for accessing ADBv2 

Starting Up 

The first time you start the ADB, you will be prompted to select the state with which you 
will be working. If no data exists for the current cycle, you will be asked if you want to begin 
working on the current cycle. If you click No, you will then be asked to select an existing cycle. 
The ADB will default to this selected state and cycle the next time you start the ADB. You can 
change the state and cycle you are working with at any time using the Data menu. 

Installing the Sample Data 

Unzip the contents of the ADB_SampleData.zip file into the “ADB_SampleData” folder 
on your C:\ drive. 
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Tutorial Organization 

This tutorial uses sample data that comes with the ADBv2. The first two exercises are 
“stand alone;” however, starting with Exercise 3, each exercise builds on the previous exercise. 
Therefore, these exercises should be completed in order, as entering data other than what is listed 
in the tutorial will result in data scenarios inconsistent with the tutorial. 

All the exercises include text descriptions of the program functions and associated 
concepts, as well as step-by-step instructions that you should follow on your PC. The step-by-
step instructions are highlighted in gray text boxes, separate from the text, as shown below. 

1. This is an example of a text box that contains instructions for this tutorial. 
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Exercise 1. Exploring ADBv2  

How to Browse and Review Data, Insert Mercury Reduction Strategy (5M) Documentation, 
and Add Atlas Information  

1. Open the ADB by clicking Start->Programs->ADBv2 for [version]->ADBv2.  

 

For Microsoft Access 

2. If you have never accessed the database before, or if you have deleted or moved the 
database since you last accessed it, navigate to the ADBaccess.mdb database in 
C:\ADB_SampleData. 

 

For Oracle 

 Log on by entering the following: 

 Database Name: ADB 
 User name:  ADBUSER 
 Password:  ADBUSER (or check with your DBA for the appropriate  
    password). 
 

For SQL Server 

 Log on by filling out the “Connect to SQL Server” dialog box.  

A.  If the database is installed locally, make sure (local) is the server name. 
Otherwise, enter the server name the ADB is installed on. 

B.  Choose a Security Option. If you choose Use Specific User Name and Password, 
you will need to enter a User ID and or Password. NT Security does not require a 
User ID or Password. 

C.  Choose ADB from the Databases drop-down list and click Log On. 
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3. If your computer has been used to access the database before, the ADB will open with the 
state and cycle that were chosen during the first login. If the database has never been 
accessed from your computer, you will be prompted to select a state and cycle.  

 

4. If you are prompted for “state,” specify TN (Tennessee) for state and click OK. When you 
get a message saying there is no data for this cycle, click No. 

Note: If you have previously opened the ADB, go to the Data drop-down menu and select 
Change State. Select TN in the Choose State drop-down menu and click OK. To change the 
Cycle, go to the Data drop-down menu and select Change Cycle. Select 1999 from the Choose 
Cycle Year drop-down menu and click OK. 

 
 

5. Next, select 1999 for the “Choose Cycle Year” dialog box and click OK. 

The main screen of the ADB features six directional buttons: 

Assessments – If you log into the database as a user with administrative privileges, you 
can use this button to add and make changes to the assessment data in the database. 

Impaired Waters 303(d) – This button allows a user to view information about impaired 
Assessment Units (AUs) and manage their categories. 

Browse – This button allows a user to view data in the database, even if he or she does 
not have administrative privileges. 
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Atlas Information – This button allows a user to independently track the total water size 
in the state according to each source and/or scale cited.  

5M Documents – This button allows you to enter a URL or description of the mercury 
program and how the program meets the recommended elements, which are both required 
by the Clean Water Mercury Guidance if using subcategory 5M. 

Exit – This button closes the ADBv2. 

Browsing the Assessment Data 

The Browse features provide a very quick and easy way for you to access information in 
the ADB. You do not need to have administrative privileges to access the browse features, so 
people in your agency may access database information through Browse without affecting the 
integrity of the data. 

Full Browse 

1. Click on the Browse button, then click on the Full Browse button. 

 

 

The Full Browse option allows you to see all of the data in the database by tabbed 
sections. You can click on different tabs to view the different types of data in the ADBv2. When 
examining the tables, you can click on the field names and the table will be sorted by that field. 
You can control the sort order using the Order by: drop-down list. Clicking on a field name also 
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populates the Search in Active Column for: list box with all of the values from that field. This 
allows you to quickly locate the specific values you are interested in reviewing.  

2. Click on the Uses tab and then click on the USE DESC field. This sorts the table by Use 
Description. 

 

3. Choose Fish and Aquatic Life from the Search in Active Column for: drop-down list. 
Click GO. This will take your pointer to the first record that has Fish and Aquatic Life in 
the USE DESC column.  

You can scroll through the list and see those AUs that are “Fully Supporting” the Aquatic 
Life Use, the AUs which are “Not Supporting,” and which AUs have “Insufficient Information.” 
You can search for data in other tabs in the same way. Feel free to examine the other data 
available through this Browse feature.  

If you want to export the data in your Browse screen, click the Export button. This will 
create a comma delimited (.csv) file in a location that you specify. 

4. Click on the CLOSE button, located in the top left corner, when you are finished 
exploring the Browse feature. 

 

Browse by Category 

This dialog features the same tabs as the “Browse” dialog box; however, the information 
shown for each tab only applies to the AU that is currently selected in the Assessment Units table 
on the upper left part of the screen. Similar to the other browse tables, you can sort this table by 
clicking on one of the columns, and then search for values in the active column. This feature is 
particularly useful if you want to look at the information associated with a specific AU.  

1. In the “Browse Options” dialog box, click on Browse by Category. Select Category 5 
from the Select a Category drop-down list. 
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The database selects all the AUs that are in Category 5; in other words, AUs that are 
impaired or threatened for one or more designated uses by a pollutant(s) and require a Total 
Maximum Daily Load (TMDL). From the screen, you can view the number of AUs, the water 
types, and the associated total sizes in the selected category. 

2. Click the CLOSE button twice to return to the Main database screen. 

 

Impaired Waters 303(d) 

The Impaired Waters 303(d) feature works similarly to the Browse feature. It allows you 
to view causes by Category, TMDL ID, 303(d) Listing IDs, Cause, and Source. You can also 
update the data through the Manage Causes button. 
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1. Click on the Impaired Waters 303(d) button. The Impaired Waters screen will appear.  

 

You can view impaired waters by choosing one of the Selection Options. Note that you 
may not get results if there is no data in the ADB that meet the selection criteria. For example, no 
AUs will appear in a Choose IDs by Category search for Category 4B waters unless you have 
specified an expected to meet attainment date for at least one impaired AU.  
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2. Click the button beside Choose by Cause. Next, make sure the button for Specific Codes 
is selected and choose Fecal Coliform from the drop-down list. 

 

If you had clicked General Codes, you would have been able to choose from general cause 
categories, such as Metals and Pathogens. 

3. Select TN06030003001_0500 Sinking Creek from the Assessment Units box. 

Now you can view the data associated with the AU by clicking the tabs in the same way that you 
did in the Browse feature. You can also click the Manage Causes button to add TMDLs, 303(d) 
IDs, Expected to Attain Dates, and Implementation Actions.  

Note: Similar to AU IDs, 303(d) list IDs are unique identifiers for water segments. While 303(d) 
list IDs uniquely identify Category 5 waters, they can be separate from an AU ID. 

4. Click the Manage Causes button to the right of the ID list. The Cause Information: 
303(d) screen will appear. 

 

5. Select the Fecal Coliform impairment in Category 5. Hold down the left mouse button 
and drag the impairment to Category 4A. The Assign TMDLs screen will appear. 

If this is your first time using the ADB, the list of TMDLs must be downloaded before 
you can view and assign TMDLs to an AU.  

6. Click the Refresh TMDL Snapshot button located midway on the right side of the page. 
The list of TMDLs will begin downloading. It may take a few minutes to complete. 

The most current list of EPA-approved TMDLs is kept in the National TMDL Tracking 
System (NTTS). Each time you refresh the TMDL snapshot, the ADB downloads a recent 
version of the TMDL list onto your hard drive; Therefore, you will want to click the Refresh 
TMDL Snapshot button every few weeks to ensure that you are viewing current TMDL 
information. The date of the last snapshot is located in the upper right corner of the screen. 
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7. Scroll through the list of TMDLs until you find the Sinking Creek TMDL. Highlight the 
record.  

 

8. Select it and click View TMDL Information. This will open a new window and direct 
you to the TMDL stored on EPA’s Web site.  

 

9. When you are finished viewing the TMDL, close the Internet window to return to the 
ADB. 

 

10. Now click Assign TMDL to Cause. A prompt will appear asking if this is a delisting. 
Click No. 

The TMDL has now been associated with the AU.  

11. Close the Assign TMDLs, Cause Information: 303(d) and 303(d) Impaired Waters 
screens to return to the main ADB screen. 
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Adding Atlas Information 

The Atlas Information feature allows the user to do the following:  

 Include information for water types which may not be supported for individual 
assessment units (e.g., canals)  

 Store the number of waterbodies as indicated by various geographic scales 
 Report the total sizes of waterbodies according to several sources.  

 
The data stored within the Atlas Information fields is independent of data related to 

individual AUs and therefore does not affect the assessment calculations or reports produced by 
the ADB. From the Atlas Information screen, you can view, create, update, and delete records. 

1. From the Main database screen, click on Atlas Information. 

 
 

2. Click Add New to begin creating a new atlas record. 

 

3. In the “Add New Atlas Information” dialog box, enter the information displayed below. 
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4. When you are finished entering the data, click Add. A prompt box will appear indicating 
that the information has been added. Click OK to return to the Atlas Information screen. 

New topic names may be added to the drop-down list by modifying the Atlas Information 
elements. To add new topic names, go to the Modify menu located in the tool bar at the top of the 
screen. Choose Atlas Topic Items from this menu. From here, you may add as many water types 
to each atlas topic as needed. Click Cancel to return to the Add New Atlas Information screen. 

5. Highlight the record that you just created by clicking on the arrow next to the record. In 
the lower left corner of the screen, the atlas information for the selected record will 
appear. You can update the atlas information from these boxes. In this case, we are going 
to update the scale to 1:24K. Type in “1:24K” in the Scale text box in the lower left 
corner of the dialog box. 
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6. Click Update to save this information. A dialog box will open that says, “You are about 
to update the atlas information in the database. Continue?” Click Yes to confirm the 
update. 

Notice that the scale column in the record has been updated to reflect the change you just made. 

7. Click CLOSE to return to the main ADB screen. 
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Mercury Reduction Strategy (5M) Documentation 

The 5M documentation feature of the ADB allows you to add a 5M related website link 
(URL) and comments to the database using plain text or Rich Text Format (RTF). RTF allow you 
can create comments that are formatted for easy reading, as well as add color, bullets, bolding, 
underlining, italicizing, different fonts, and font sizes.  

1. In the main database dialog box, click on the 5M Documentation button. 

 

2. Type the information below into the “Comment” dialog box and click the Save button. 

 

 

The comments are now associated with the specific cycle. You can select the View button to 
open the weblink in Internet Explorer. 

If you have an existing text or rich text file containing 5M comments, you can import 
them by using the Get From File button on the lower middle of the “Mercury Reduction Strategy 
Documentation” window. Use the “Choose Location” window to navigate to the location where 
the file is saved and click Open. The Comments text box should now contain the contents of 
your file. Click Save to associate the text with the cycle. You can also save the 5M comments to 
a separate text or rich text file by clicking the Save to File button and navigating to where you 
would like the file to be located. You can then use the Open File button to retrieve your saved 
comments. 
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3. Click CLOSE to return to the main database screen. 

 

Assessments 

1. In the main database screen, click the Assessments button. 

When Assessments is selected from the main dialog box, the user is able to access 
assessment information for any AU in the database, and then view, add, update, or delete AU 
information from this screen. Assessment information associated with an AU may include 
designated uses, assessment metadata, causes of impairment (or observed effects), sources of 
impairment, and assessment category. You can access this information by using the buttons on 
the sidebar at the left. 

2. In the “Select an Assessment Unit” dialog box, choose Dry Creek from the Or By Name 
drop-down list and click GO. 

Dry Creek is associated with several AUs, so you will need to select a specific AU before 
you can look at AU information.  

 
 

3. Select TN05130107023_2000 and click OK. 
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The database will retrieve information for the AU specified, displaying the Assessment 
Unit ID, as well as the Location Description and the Water Type and Size. The text beside the 
sidebar buttons indicates some additional information about the AU, such as whether there is 
information for each of those data elements and, if so, how many uses, causes, or sources exist. 
This sidebar indicates this AU has three uses and two causes of impairment. 

Causes and Designated Uses 

1. Click on the Causes button. 

 

Clicking on the Causes button from the Assessment Units screen gives you information 
at the AU level. The “Causes” dialog box indicates the causes for this AU are Iron and 
Manganese. Click on either of these to see the associated designated uses or double-click on 
either of them to view cause definitions. 

2. Click Iron, then on Manganese. Under Associated Uses, you can see that the Fish and 
Aquatic Life use is impaired by both of these metals.  
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3. Click on the Uses button at the bottom right of the screen. 

 

  
The Uses screen displays the designated uses that have been assigned to this AU. As you 

can see, this AU, whose Fish and Aquatic Life use is impaired by Iron and Manganese, is “Not 
Supporting” the designated use. 
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4. Click on the Assessment Units button to return to the main Assessment Units screen. 

 

 

 

Summary 

In this exercise, you learned how to: 

 View, sort, and export data in the ADB using the Browse features  
 View assessment information associated with impaired waters  
 Add a Monitoring Strategy and/or Assessment Methodology document to the ADB 
 Add Atlas Information 
 View data in the ADB by using the sidebar buttons on the Assessment Units screen 
 Manage causes using the Impaired Waters: 303(d) Information screen. 

In Exercise 2, you will learn how to add new AUs to the ADB and how to assign 
designated uses and assessment information to these new AUs. 
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Exercise 2. Creating an Assessment Unit 

This exercise will show you how to add a new AU to the ADBv2, how to assign 
designated uses, and how to enter use support information. It will also show how the ADBv2 
automatically assigns the AUs to the categories defined in the Guidance, as well as how to export 
a category report table. 

1. Click the Create New Assessment Unit button on the Assessment Units screen. A dialog 
box will appear requesting that you add Assessment Unit ID, Name, and Location 
Description. All of these data elements are required. The database will not allow you to 
proceed without entering information in each box. Fill out the dialog box using the 
following information and then click Add. 

 

Note: If you are attending a class where you are using the ADBv2 over a network, each student 
must use his/her own AU ID. Otherwise, you will all be accessing the same record and cause 
problems with the exercise. The instructors will assign you a letter to use in place of the x. For 
example, if the instructors assign you the letter A, each time you see “AU-1x” use “AU-1a.”  

Next, a dialog box will appear requesting you to add Assessment Unit Information. The 
Water Type drop-down list contains a number of different kinds of waterbodies that you can 
choose from to describe the water in your AU. Your AUs can be composed of multiple 
waterbody types. Define one type first, then you can define the others later. The Size units 
depend on the Water Type that you choose. 
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2.  Fill in the information according to the following example and click Add. 

 

 

The information you just entered will be displayed on the Assessment Units screen. 
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Adding Designated Uses, Use Support, and Assessment Metadata 

3.  Click the Add Uses button to assign designated uses to this assessment unit. 

 

 

 

4.  Select the following designated uses (to select nonsequential items in the list, hold down 
the Control key) and click ADD. 

 

The Uses screen will appear. All newly added uses are defaulted to Not Assessed.  

Note: The Designated Uses listed are from EPA’s Water Quality Standards Database (WQSDB), 
which is populated with the data from the States’ Water Quality Standards (WQS) documents. If 
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a Use is not specified in your WQS document, it will not be available in this list. For more 
information on the WQSDB, visit http://www.epa.gov/wqsdatabase.  

5.  Double-click on Fish and Aquatic Life to add an assessment to that Designated Use. 

The Assessment Documentation screen will appear. This screen allows you to add use 
support status, assessment data, assessment types, assessment methods, user flags, and threatened 
status flags to the selected designated use. The Use Support field is always required for each 
designated use. All other fields are considered assessment metadata and are either conditionally 
required or optional. 

6.  In the Use Support drop-down box on the “Assessment Documentation” dialog box, 
choose Fully Supporting. 

 
 

When use support status is changed from not assessed, assessment type and assessment 
confidence information must be entered as well before you can return to the Uses screen. 
Available Assessment Types and Confidence of Assessment are the only conditionally required 
metadata elements. Therefore, if you delete all of the assessment types associated with a 
designated use, the use support will be changed to “Not Assessed.” 
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7. Under “Assessments Performed,” click on ADD to specify Available Assessment Types 
and Confidence of Assessment.  

 

8. A prompt box will appear to ask if you would like to save these changes. Click Yes and 
the “Add Assessment Metadata” dialog box will appear. Enter the information specified 
below: 

 

 
 

There are seven assessment types available to choose from in the drop-down box: 
Biological, Habitat, Physical/Chemical, Toxicological, Pathogen Indicators, Other Public 
Health Indicators, and Other Aquatic Life Indicators. Further information on assessment 
types is available on page 21 of the ADB User’s Guide.  

Four levels of confidence or quality of the data used to make the assessment can be 
associated with these assessment types:  Low, Fair, Good, and Excellent. How a state assigns 
assessment type and confidence should be explained in its Assessment Methodology Document.  

9. Click ADD to return to the Assessment Documentation screen. 

Feel free to explore and enter other types of assessment metadata on this screen. For 
example, creating a user flag can be an invaluable tool for internal State data tracking because it 
can be populated as the user sees fit and has no effect on an AU’s category. Some users have 
chosen this field to track designated uses that were “Partially Supporting” by the State. This field 
accepts free text and selections from the drop-down list (only populated if you have entered user 
flags for other designated uses in the database). 

Note: Changing threatened status will change the designated use to be considered impaired, 
affecting the category definitions. Be sure to leave this button set to “No” when saving changes 
to the assessment metadata to avoid obtaining different category definitions in the following 
exercise section.  
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The user should be certain that a given metadata category is related to the specific use 
being assessed. For example, it would not make sense to have a Habitat assessment associated 
with a Primary Contact Recreation use. The State’s Assessment Methodology Document should 
describe what types of assessment metadata categories can be associated with each WQS 
designated use. 

We also know that the assessment took place January 1, 1998.  

10. In the Assessment Date field, type 01/01/1998 in the text box.  

You can also use the “Calendar” icon to choose the assessment date that needs to be 
added. 

11. Click Save. Then click the “Uses” icon to return the Uses screen.  

 

 

The “Fish and Aquatic Life” use designation is now located under Assessed Uses. 



ADBv2 Tutorial Exercise 2 – Creating an Assessment Unit 

27 

 

 

12. Click the “Assessment Units” icon in the lower left corner to return to the main 
“Assessment Units” dialog box. 

 
 

13. Click Create New Assessment Unit. Fill in the “Add Assessment Unit” dialog box with 
the following information and then click Add. 

 
 

14. For the Waterbody Type, select Creek, and enter 10 for Size in Miles. Click Add. 

This AU also includes a lake. You can add additional water types by clicking on the Add 
Type button just below Water Type. 



ADBv2 Tutorial Exercise 2 – Creating an Assessment Unit 

28 

 

15. In the Information screen, click Add Type. Choose Freshwater Lake for Waterbody 
Type and 5 for the Size in Acres. Click Add. 

 

16. Now that the waterbody types have been added to the AU, we need to add uses. Click on 
the Add Uses button. 

 
 

17.  Choose Domestic Water Supply, Fish and Aquatic Life and Irrigation for Uses (you can 
hold down the Control key to select nonsequential items in the list) and click Add. 

 

18.  Double click on  Domestic Water Supply under Unassessed Uses to add assessment 
information. 

 

19.  For Use Support, choose Not Supporting. Click Save. 

 

20.  In the “Assessment Documentation” dialog box, click Add under “Assessments 
Performed” to add assessment type and confidence.  
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Let’s assume that the water in the AU has just been tested and was found to be 
contaminated with fecal coliform bacteria. This could be considered an “Excellent” confidence 
assessment type because it was based on recent water quality tests. 

21.  For Assessment Type, choose Pathogen Indicators and for Confidence of Assessment 
choose Excellent. Click Add.  

 

22. In the Assessment Date field, type 01/01/1998 in the text box.  

 

23. Now click Save at the bottom of the screen and click the Return to Uses button: 

 
 

Adding Data to Multiple Uses 

1. Use the Shift key to select both uses under Unassessed Uses in the “Uses” dialog box.  

 

2. Click on the Assessment Documentation button on the sidebar. 

 

3. Under the Use Support drop-down box, pick Fully Supporting. Click Save. 
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4. Click the Add button under the “Assessments Performed” dialog box to add assessment 
type and confidence. Choose Habitat for Assessment Type and Fair for Confidence of 
Assessment. Click Add. 

 

Summary 

In this exercise, you learned how to add an AU and designated uses to the ADB. In 
Exercise 3, you will learn how to enter causes and sources into the ADBv2.  

 

5. Click Save at the bottom of the Assessment Documentation screen and click the Return 
to Uses button. 
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Exercise 3. Augmenting an Assessment Unit 

In the last exercise, you added two AUs to the database, assigned designated uses, and 
entered information about use support. In this exercise, you will learn how to enter causes that 
affect use support and the associated sources of impairment. 

So far, you have added an AU-2x that has two waterbody types and assigned three uses to 
the AU. Two of these uses are fully supporting based on a fair confidence assessment, and the 
other is impaired based on a high confidence assessment. Because Domestic Water Supply is 
not supporting, you will need to add the causes which have impaired this use. 

Note: If you are restarting the tutorial after a break, go to the Assessment Units screen from the 
Main screen, in order to get to the “Uses” screen. 

1.  In the Uses screen, highlight Domestic Water Supply under Assessed Uses. Then click on 
the Causes button on the left side of the screen to add causes of impairment.  

 

It has been determined that this use is impaired for total coliform and sedimentation. To 
add these causes, you can choose the “Add Causes” icon on the left side of the screen or click the 
Add button under the “Double-click to show cause description:” dialog box. 

2. To add the total coliform cause, click on the Add Causes button on the left side of the 
screen.  
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3. Click on the SHOW ALL button. Because we will be adding two causes, also select the 
Multi-Select button under SELECTION OPTIONS. Find and select 
Sedimentation/Siltation from the list. Hold the Control key down to select Total 
Coliform from the list as well. 

 

Because there are about 500 causes in the database, look-up tables are available that 
enable you to choose from a shorter list under the SHOW ONLY button on the ADD CAUSES 
screen. You can also create custom groups for causes that are common in your state. In 
Exercise 7, we will explore how to create custom cause and source groups.  

3. Click the ADD button below the causes list to return to the Causes screen.  

Sedimentation/Siltation and Total Coliform should now be associated with the Domestic 
Water Supply use for AU-2x.  

Pollutant vs. Nonpollutant 

Every impairment can be flagged as either a pollutant or a nonpollutant. Whether a use is 
impaired by a pollutant can affect an AU’s category. By default, all causes will be flagged as 
pollutants. To change this causes default, click on the Modify menu, and select Pollutants/ 
Nonpollutants. If an impairment is defaulted as a nonpollutant, every time that impairment is 
added to a use, the pollutant flag will be set to “No.”  Changing the default pollutant status of a 
cause will not affect any causes already listed. Furthermore, the pollutant flag of a cause can be 
changed at any time. 
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Entering Sources for Causes 

Thus far, we have entered the uses, use supports, and causes for AU-2x. In some cases, 
you may also be able to define the source of the cause. The ADB contains approximately 200 
potential sources which were compiled from the 319 Nonpoint Source Program and the Office of 
Watershed Management Permitting documents.  

For AU-2x, the source of sedimentation/siltation and total coliform is known to be 
Permitted Runoff from Confined Animal Feed Operations (CAFOs). 

1.  Highlight the Total Coliform cause. 

 

2.  Click on the Sources button on the left side of the Causes screen: 

 

Although we initially only highlighted Total Coliform, we can also choose 
Sedimentation/Siltation by highlighting both causes in the lower right corner of the screen. 

3.  Under Causes Affected, make sure the boxes for both of the listed causes are checked 
(Use the Shift key to select and check them both). 
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4.  Click the ADD button located under the Sources list box. 

The Source list is organized in the same format as the Causes list. When adding causes, 
we looked through all of the causes to find Sedimentation/Siltation and Total Coliform. To add 
the sources, we will use the existing source groups to locate our source. 

5.  Click on the SHOW ONLY button and choose Agriculture-Animal Feeding/Handling 
Operations from the drop-down list. 

 

6.  Select Permitted Runoff from Confined Animal Feed Operations (CAFOs) and click 
ADD. The selected source will appear in the text box for Sources for Total Coliform.  
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7.  In the text box, highlight Permitted Runoff from Confined Animal Feeding Operations. 
Both Sedimentation/Siltation and Total Coliform should become checked and 
highlighted under the Causes Affected. 
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Changing Source Confirmation 

The “Confirmed” heading beside the source name defaults to “Not Confirmed,” allowing 
the user to enter a suspected source and confirm it later. A confirmation could be made after the 
development of a TMDL or after other information is obtained; however, it is not necessary to 
wait for the development of a TMDL if the information is already accurate enough to confirm the 
source. 

1. To change a source’s confirmation, return to the Assessment Units screen by clicking on 
the Assessment Unit button on the left side of the screen. Then click on the Sources 
button on the left side of the Assessment Unit screen. 

 

2.  Select the Source from the Source list that you want to confirm and click the Confirm 
Sources button on the bottom of the screen. 

 

3. This will take you to the Confirm Sources screen and display which Sources are 
confirmed and which are suspected. You can see that the Confirm radio button is selected 
in the Confirm or Suspected box. Click Close on the bottom right side of the screen to 
return to the Sources screen. 

 

4. Click the Return to Assessment Units button. Click on the Uses button on the left side of 
the Assessment Units screen. Select the Domestic Water Supply Use and click Causes on 
the left side of the screen to begin managing the 303(d) Information. 
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Managing 303(d) Information 

From the Cause Information: 303(d) screen, you can manage AUs that you designated 
as “Not Supporting” a designated use. Causes are defaulted to the Category 5 column in the 
“Cause Information: 303(d)” dialog box. However, from this screen you can move a cause as 
needed into the Category 4B and Category 4A columns. The Cause Information: 303(d) screen 
can also help you determine which uses have not yet been assigned associated causes. 

1. Click the 303(d) Information button located in the lower center of the Causes screen.  

The Cause Information: 303(d) screen will appear. 

 

Total Coliform is expected to no longer impair AU-2x by 2004; therefore, we can move 
this cause to the Category 4B column because we have an Expected to Attain Date.  

2.  Select Total Coliform from the Category 5 column. Hold down the left mouse button and 
drag the cause to the Category 4B column. 

The Assign Expected to Attain Dates TMDL Alternative Documentation screen will 
appear. The default values for the Cycle by which attainment will take place  standards will be 
attained and Cycle when monitoring will next take place will be the next reporting cycle. Users 
can also provide a related URL and designate whether the pollutant source is a point source, non-
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point sources or both. If point source or both is selected the user can also enter in associated 
NPDES IDs and other point source information. 

3.  Change both dates to 2004 and click UPDATE. Click OK when you get an “Update 
Complete” message. 

Note: Both of the cycle dates are required. You can accept the default or add a different  cycle. If 
you delete one or both of the cycle dates, the validation check (discussed in Exercise 5) will give 
you a message saying there are dates missing. 
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4. A message prompt will appear and ask if this is a delisting. Click Yes. 

A delisting occurs when an AU is removed from the State’s 303(d) list for a particular 
cause of impairment (in this case, Total Coliform). The Delisting Information screen allows 
you to keep track of causes that were previously listed, the dates of delisting, and the reason or 
rationale for delisting. 

 

5. Because the delisting was prompted by moving Total Coliform to the Category 4B 
column (expected to meet attainment), the delisting reason has already been populated. 
Click UPDATE, then click CLOSE.  

Note: The Delisting Reasons provided in the drop-down box on the Delisting Information screen 
are taken from the Summary Rationale for Listing/Delisting in the Guidance. 
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The Cause Information: 303(d) screen will now reflect the changes you have 
implemented. 

 

Users may also add 303(d) list IDs and TMDLs through the Cause Information: 303(d) 
screen. To add a 303(d) list ID, click on a cause under the Category 5 column and click the View 
Information button. To enter a TMDL, click and drag the appropriate cause to the Category 4A 
column and the Assign TMDLs screen will automatically open. To add a TMDL, scroll through 
the list or use the Search feature to locate the TMDL that matches the AU. Select it and click 
Assign TMDL to Cause.  

You may remember from Exercise 1 that the list of TMDLs is populated using 
information from the NTTS. Because we have added AU-2x for the purposes of this tutorial, no 
matching TMDL will be found in the list. Instead, we will use the TMDL Information screen to 
indicate that creating a TMDL for AU-2x is a high priority.  

6. Click CLOSE to exit the Cause Information screen and return to the Causes screen. 

 

7. Highlight Sedimentation/Siltation in the text box. Several elements on the screen that 
were previously grayed out should now be accessible. 
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8. Click on the TMDL Information screen on the upper right side of the screen. The 
following screen should appear: 

 

9. Select High from the TMDL Priority drop-down box. Click the UPDATE button to 
save the changes. 

 

10. An Update Complete message prompt will appear. Click OK. 

 

11. Click the CLOSE button on the TMDL Information window to return to the Causes 
screen.  

 

12. Click the “Assessment Units” icon on the left side of the screen to return to the main 
Assessment Units screen. 
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Determining Assessment Categories 

EPA’s Guidance calls for all water quality attainment statuses to be fully described for 
each AU on the basis of a five part categorization of use support. As with previous guidance 
documents, assessment category is fundamentally decided at the designated use level. The 
ADBv2 will automatically assign AUs to the appropriate category based on information you 
enter about the use support rating of the AU. You can view the category definition assigned to an 
AU at any time by clicking on the Determine Category button in the sidebar or read a detailed 
description of each category in the Guidance by selecting Show Category Definitions from the 
View menu. 

1. Make sure that you are still viewing AU-2x assessment information. Click on the 
“Determine Category” icon: 

 

A text box will appear indicating that the AU is in Category 5. This shows that the AU is 
not attaining at least one of its designated uses (Domestic Water Supply).  

2. Click OK. 

 

3. On the View drop-down menu, click on View and select Show Category Definitions. 
Select Category 5 from the Select a Category drop-down list. 
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4. Look at several more of the categories, and click CLOSE when you are finished. 

You can also view the categories of each individual use. Users can determine the 
attainment of AUs at the AU level, the Uses level, and the Causes level by switching from Single 
Category Reporting (assessment-level category determinations) to Multi-Category Reporting 
(use- and cause-level category determinations).  

5.  In the bottom left corner, click the Category Reporting button. 

The Assessment Unit Category Reporting screen will appear. Any modifications 
performed on this screen are specific to the AU-2x assessment unit and are not applied to all AUs 
in the database. 

6. Select the Multiple Category button. Check both boxes beneath the Multiple Category 
option to view categories at both the uses and causes level. 

 

7. Click UPDATE, then click OK to return to the Assessment Units information page.  
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8. Click on the “Determine Category” icon: 

 

The text box should look like: 

 

9 Click OK to close the dialog box. 

Updating Assessment Information 

The ADBv2 allows a user to update an AU’s data through the Change Use Attainment 
screen. For instance, you could receive some new data about the AU you have entered that leads 
you to believe the water quality standard for Fish and Aquatic Life is threatened for this AU. This 
would mean that the AU is currently attaining its water quality standard for the Fish and Aquatic 
Life use, but that you predict it will not be attaining the water quality standards by the next 
reporting cycle. 
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1. From the Assessment Units screen, specify AU-1x is as the Assessment Unit ID. 

 

2. Click on the Determine Category button:  

 

             Please note that the AU is currently in Category 2.  Click OK.  

 

3. Now click on the Uses button:  

 
 

4. Highlight Fish and Aquatic Life in the “Assessed Uses” dialog box. Under the dialog 
box, click on the Change Use Support button. 

 

5. In the “Use Attainment” dialog box, click YES under Threatened and then click the 
CHANGE button. 
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The Uses screen now indicates that Fish and Aquatic Life are threatened. 

 

6. Now click on the Determine Category button: 

 
 

7. You will notice that adding a Threatened designation to the AU moved it from 
Category 2 to Category 5. Click OK in the message box.  

 

8. Click on the Assessment Units icon. In the bottom left corner, click the Category 
Reporting button. 

 

9. Select the Multiple Category button. Check both boxes beneath the Multiple Category 
option to view categories at both the uses and causes level. 

 

10. Click Update, then click OK to return to the Assessment Unit information page. 

 

11. Click on the Determine Category icon: 

 

 



ADBv2 Tutorial Exercise 3 – Augmenting an Assessment Unit 

47 

The AU should now be in Category 3 and Category 5. 

12. Click OK. 

Summary 

In this exercise, you learned how to add causes and sources, manage 303(d) information, 
and associate delistings with AUs. You also learned how attainment categories are determined 
based on varying assessment information.  

In the next exercise, you will learn about the Connections Module and how you can use it 
to connect to data in tables outside of the ADBv2.  
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Exercise 4. Additional Features of the ADB 

This exercise focuses on illustrating additional data storage and data export areas in the 
ADB, such as where to add additional locational information, comments, files, observed effects, 
or implementation actions to AUs, as well as how to export category data. 

1. From the main ADB screen, click the Assessments button to access the Assessment 
Units screen. 

Adding Other Location Information 

The ADB allows you to enter Other Location Information, including hydrologic unit 
code (HUC), county, and latitude/longitude. Unlike the Location Description field you filled out 
in Exercise 2, no fields in the “Additional Locations” dialog box are required for creating an AU. 

1. Choose  AU-1x as the Assessment Unit ID in the By ID: drop-down list.  

 

2. Click the Other Location Info button in the lower left corner of the screen. The 
Additional Location Information screen will appear. 
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3. Under the “Location Descriptors” dialog box, click the ADD button. 

 
 

4. Fill out the “Add Location Information” dialog box as shown below. 

 

5. Click ADD. 

“Additional Locations” should now include the HUC you just added. You may add as 
many location descriptors as needed.  

To add location types or location descriptions to the list available in the drop-down box, 
go to Modify > Locations in the toolbar at the top of the screen and add the respective locational 
types and descriptions. 

6. Click CLOSE to return to the “Assessment Units” dialog box. 

Adding Comments 

ADBv2 allows you to add comments to AUs using Rich Text Format (RTF). This means 
that you can create comments that are formatted for easy reading, as well as add color, bullets, 
bolding, underlining, italicizing, different fonts, and font sizes.  

1. Click on the Add Comment button in the lower left corner of the Assessment Units main 
screen. The Comment screen will open. 

 

2. Type the information below into the “Comment” dialog box and click the Save to AU 
button.  
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The comments are now associated with the AU. You can access this information in the 
main Assessment Units screen by clicking on View Comment.  

If you have an existing text or rich text file containing AU comments, you can import 
them by using the Get From File button on the lower middle of the “Comments” window. Use 
the “Choose Location” window to navigate to the location where the file is saved and click 
Open. The Comments text box should now contain the contents of your file. Click Save to AU 
to associate the text with the AU. You can also save comments from the AU to a separate text or 
rich text file by clicking the Save to File button and navigating to where you would like the file 
to be located. You can then use the Open File button to retrieve your saved comments. 

3. Click CLOSE to return to the main Assessment Units screen. 

Implementation Actions 

For AUs that you have moved to Category 4B and entered an Expected to meet 
standards by date, you can also include an implementation action. Implementation actions can 
help define what a State plans to do for waters that are expected to attain its standards. There is 
no set list of approved EPA implementation actions, but rather a State should enter what seems 
practical. All implementation actions require a date by which the action will take place.  

1. Choose 4B from the Limit list by drop-down box in the “Select an Assessment Unit” 
dialog box. 

 

2. In the By ID: drop-down list, select TN06030003060_1000. 
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3. Click on the “Uses” icon.  

 

4. Highlight Recreation under the “Assessed Uses” dialog box, then click on the “Causes” 
icon. 

 

5. Click on the 303(d) information button in the middle lower portion of the screen.  

 

6. Highlight Nitrogen, nitrite in the Category 4B column and click on the Implementation 
Actions button.  

 

7. When the Implementation Actions screen appears, click the Add Implementation 
Action button. 

Like the Comments feature, you can type implementation actions directly into the 
database or import a text file that you have previously created.  
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8. Click the Add Action button and use the calendar feature to choose February 1, 2006. A 
message prompt will appear asking if you would like to continue because the Action 
Date is after the Expected to Attain Date. Click Yes. 

 

9. Next, click the Get From File button and select the implement.rtf file located in the 
ADB_Sampledata directory. 
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10. Click the Save Action button and then click OK when you get the “Save Successful” 
message. 

 

11. Close both of the Implementation Actions screens. Close the Cause Information 
screen. 

Observed Effects 

Observed effects are monitoring observations that may indicate a decline in water quality, 
but that may not be defined in the State WQS as an impairment. Observed effects are added to a 
designated use similarly to the way causes are added; however, observed effects can be added to 
uses that are “Fully Supporting” and/or not threatened, whereas causes cannot. Some examples of 
observed effects include Secchi Depth measurements or fish kills.  

1. Click on the “Uses” icon. 

 

2. Highlight Irrigation in the “Assessed Uses” dialog box, then click the “Observed 
Effects” icon. 
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In this example, there are signs of a nutrient problem in the lake (e.g., a nuisance algal 
growth). Although the nutrient causing the problem is unknown, it is suspected that it is 
phosphorous runoff from a nearby field. However, until further studies can be conducted, you 
might not want to label phosphorous as the nutrient of concern. Instead, you could enter Algal 
Growth as an observed effect. This way you could include a comment noting that phosphorous is 
the suspected impairment, but that additional investigation should be performed. 

3. Click the ADD button under the “Observed Effects” dialog box. The “Observed Effects” 
that are currently being used will be shown by default. 

 

4. Click the SHOW ALL button in the “CHOOSE ONE” dialog box. 
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5. Select Excess Algal Growth. Click the ADD button. The observed effect will appear in 
the “Observed Effects” dialog box. 

 

6. Click the “Assessment Unit” icon to return to the main Assessment Units screen. 

Making a Custom Cause Group 

Custom cause groups allow the user to group several causes that may, for instance, be of 
particular concern to health officials or are frequently associated with each other. You may create 
as many custom cause groups as needed to expedite the data entry process. 

1. On the menu toolbar, click on Modify->Look-up Groups->Cause. 

 

2. In the Cause Groups screen, type Group 1x (Note: Use the same letter you have been 
using for AU ID) in the New Group Name text box and click on Create Group. Group 
1x will appear under the Group Name text box. 
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3. Group 1x will contain causes that are of particular concern to public health officials. 
Click the Show All button and a list of causes will appear under Name. Choose Aldrin 
and Arsenic and click the down arrow. 

 

The down arrow will move the impairment to the box at the bottom of the screen, which 
displays the causes included in the group that you create. 

 

4. Click on the Show Only button and select Pathogens from the drop-down list. A list of 
pathogens will appear under Name. 

 

5. Select Total Coliform and click the down arrow. Click CLOSE at the bottom to close 
this dialog box.  

You have now created a custom cause group. To add these causes to an AU, select the 
SHOW ONLY button on the ADD CAUSES screen and highlight Group 1x in the drop-down 
list. Custom source groups can be created in the same fashion as custom cause groups under 
Modify->Look-up Groups->Source. 
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Export Category Listing 

The Data Exports menu allows you to produce five different lists of AUs and save them 
as a .csv file. The available exports include the following:  

 303(d) B AUs on the 303(d) list. 
 Category 4A B Impaired or threatened AUs that have a TMDL. 
 Category 4B B Impaired or threatened AUs that are expected to meet the standards.  
 Category 4C B Impaired or threatened AUs that need a TMDL. 
 Category List B All AUs and their categories. 

1.  Go to the menu toolbar and select Data->Data Exports.  

 

2.  Choose Category Listing from the drop-down list and click the Export Data button. 
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3.  Save the category.csv file in your c:/ADB_sampledata directory. Note that this will 
overwrite any files previously saved with the same name. 

 

4. Close the “Data Exports” dialog box when the Exporting Data status bar is no longer 
visible. 

 

5.  If you have MS Excel on your machine, try opening the category.csv file. (In MS Excel, 
choose All files (*.*) from the Files of type drop-down list.) 

If you have a GIS coverage with the same IDs that are stored in the Assessment_Unit 
field, you can join this table to your GIS coverage and display the categories for your state=s 
waters. 

Adding Files to Assessment Units 

The ADBv2 also allows you to associate graphics or other types of files with an AU. You 
can add a .jpeg that shows a picture of the site where the assessment was performed or a lengthy 
document describing the AU. To associate a document with an AU, click Add File on the lower 
left side of the Assessment Units screen. There is no limit to the number of documents you can 
add to an AU; however, keep in mind that Oracle may not be the most efficient way to store a 
large number of documents. It may be more efficient for you to store documents on an NT server, 
rather than in your database.  
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1.  Close the Assessment Units screen, then close the ADB. 

Summary 

In this exercise, you learned how to enter additional information into the ADB, how to 
export category information and create cause and source groups. You also learned how to add 
files to an AU. 
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Exercise 5. Using the Connections Module 

The Connections Module is designed to help you work with your data outside of the 
ADBv2 environment, and it will also allow you to work with data in other databases. The 
Connections Module enables the user to directly access the ADB database and view ADB data in 
table format. These tables can also be exported for analysis outside of the ADB. Additionally, the 
module allows the user to link to tables in other databases (e.g., Oracle, MS Access, SQL Server, 
or any MS Open Database Connectivity-compliant database), which enable these databases to be 
viewed in the ADB. For example, this connection is useful if you want to store information about 
the State basin in which an AU is located. 

This feature is solely for the convenience of the ADBv2 users. Any data accessed through 
the Connections Module will not be included in the electronic submission to EPA.  

In this exercise, you will learn how to view tables within the connections module and 
bring a table into the ADB. You will also learn how to use custom queries to create tables that 
can be exported into a .csv text file, which can then be used to limit the AUs viewed in the 
database. 

Creating a New Database Connection 

The MS Access database you will be using contains some assessment information that 
was collected in the field. It is stored in a single table called TN_streams in the MS Access data 
file. 

1. Open the Connections Module by clicking on Start->Programs->ADBv2 for [version]  
->Connections. An interface with a Tables tab and a Views tab will appear. 

 
2. From the File menu, select Connect to Database. 

 

3. In the “Connect to a Database” dialog box, click on the Create New Connections button 
and then click NEXT. 
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4. From the “Connection Type” dialog box, choose Microsoft Access and click NEXT. 

 

5. In the “Connect to Access” dialog box, click on the navigation button and 
navigate to the TN_streams.mdb database in your “ADB_sampledata” 
folder. Click Open. 

 

6. Next, check the Save Connection on Finish check box. This will allow you to use the 
same connection later after you close the ADB. 

 

7. Click Test Connection. This will let you know if the database connection is working 
properly. You should get a message saying “Test Successful.”  Click OK, then click 
Finish in the “Connect” dialog box. 

 

8. You will be prompted to name your database connection. Call it TN_streams. Click OK. 
The Scenic_rivers table will appear in the Tables tab. 

 

 

 

9. Select the Scenic_rivers table, then right click on it. Choose Open. The Scenic_rivers 
table will open. 
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In this example, the Scenic_rivers table contains information about AUs, including state 

basin and whether the stream is designated as a scenic river ( “-1” indicates a scenic river, “0” 
indicates that it is not a scenic river.)  Although these data cannot be stored in the ADBv2, it is 
easy to connect to a table storing these data and update the data while you work in the ADBv2. 
To work with this table, you may access the following functions by making a column active: 

 Sort Ascending/Descending 
 Copy/Paste 
 Filter 
 Find 
 Export Data 

10. Make the STBASIN column active by clicking on the column heading and then right 
clicking on it to open the drop-down list. 

 

11. Click the Sort Ascending button. The records in the table get sorted based on the state 
basin column. 

 

12.  Close the table by clicking the X in the upper right corner. 
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Creating a Table/Database Connection 

Now that you have created a database connection to TN_streams, you need to make a 
connection between the table in the database, Scenic_rivers, and the ADB. You must also tell the 
ADBv2 how the fields in the Scenic_rivers table relate to the AUs. In this case, the AUID field in 
the table corresponds to AU ID in the ADB. 

1. Make the Scenic_rivers table active by selecting it with your mouse. Right click on the 
word Scenic_rivers in the Tables tab. Select Make New Table Connection. 

 

2. Name the connection Scenic_rivers and click NEXT. 

 

3. In the Limit Connection screen, choose AUID from the drop-down list beside Limit By: 
Assessment Unit ID.  

 

The “Limit By:” dialog box defines the relationship between the Scenic_rivers table and 
the ADB. If the table has a Cycle field or a TMDL ID field, you can further limit the records your 
table displays. Relate the cycle field in your table to the cycle in the database. The table will only 
show records for the current cycle in the database. You can limit the records by TMDL ID in the 
same way. 
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4. Click Finish. When prompted, make sure the table connection is still called Scenic_rivers 
and click OK. 

 

5. Close the Connections Module by clicking the X in the upper right corner. 

Bringing a Table into the ADB 

1. Open the ADB by going to the Start menu and clicking on Programs -> ADBv2 for 
[version] ->ADBv2. Click on the Assessments button from the main database menu. 

 

2. From the View menu, choose Show Connections. From the Existing Connections 
screen, select the scenic_rivers entry and click OPEN. 

 

 

3. Click Yes when you are asked if you want to enforce limits for the connection. 

The table can be resized so you can view both the table and the ADB screen. If you click 
on the ADB screen, it will appear on top of the Scenic_rivers table. After you resize the box, 
drag it to either the top or the bottom so you can make it active from the ADB screen. As long as 
a part of the table is visible on the screen, you can click on it to make it active.  
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You can view the records as a form by clicking on the View as Form button. If the View 
as Form button disappears as a result of resizing the table, close the table and reopen it by going 
to View->Show Connections and choosing the table. 

One advantage of connecting to the table is the ability to enter information into the table 
at the same time as you enter the AU data into the database.  
 
4. Close the Scenic_rivers table by clicking the X in the upper right corner. 

Exporting Data 

Another feature of the Connections Module is the ability to export data from the ADB to 
MS Access and/or SQL Server. You can also choose to export the data as a .csv text file, which 
is illustrated in the following example. 

For this example, let’s say that a water quality manager asks the question:  Which AUs are 
listed in Category 5 for iron, specifically for the designated use Fish and Other Aquatic Life?  In 
Exercise 1, you were able to use the ADB’s Browse feature to view, sort, and filter the data in 
table format; however, the Browse feature limits the user in performing more custom queries 
required for answering questions such as the one above. By being able to interact directly with 
the ADB tables, the user is able to directly select out data to create a new table that specifically 
answers the questions you want to ask. 

1. Return to the Connections Module by clicking the hammer icon at the top of your screen, 
or access this module through Start->Programs->ADBv.2 for Access->Connections.  

  
2. Choose File->Connect to Database. Click on Create New Connection and click NEXT. 

 

3. Choose Microsoft Access and click NEXT. 

 

4. In the “Connect to Access” dialog box, click on the navigation button    and navigate 
to the ADBaccess.mdb database in C:/ADB_SampleData and click Open. 

 

5. Next, check the Save Connection on Finish box. This will allow you to use the same 
connection later after you close the ADB. 

 

6. Click Test Connection. You should get a message saying “Test Successful.”  Click OK, 
then click Finish in the “Connect to Access” dialog box. 
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7. Name the connection ADB. Click OK. 

From this point forward, this connection will be available through the Existing 
Connections option, and you will only need to enter the password to access it. 

Performing Queries Through the Connections Module 

1.  Click on the Views tab and select the Category5_Causes view. 
 

 

2.  From the Connections menu, select Advanced SQL. The “Advanced SQL” dialog box 
allows you to create a custom query. 

 

3.  Check the boxes beside:  
ID305B, CYCLE, WATER_NAME, USE_DESC, ATTAINMENT_DESC, 
THREATENED_FLAG, CAUSE_NAME, SOURCE_NAME 

 

4. Check the Select Unique Records box. 

 

5. Under the “Where:” dialog box, select STATE from the drop-down list and enter TN in 
the box to the right of the = sign. Click the ADD button.  
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So far, your SQL structure should look like this: 

 

6. Under “Where:,” Select CAUSE_NAME from the drop-down list and enter Iron in the 
box to the right of the = sign. Click the ADD button. 

Note:  Instead of entering values at the right of the = sign, you may use the GET VALUES 
button to access a drop-down list to choose values from a selected list; however, this may be a 
slower option than entering the values directly.  
 

This statement will retrieve from the database all the AUs in the Category 5 causes that 
are in Tennessee and are impaired by iron. If you save this query, you will be able to recall this 
SQL string at any time in the future. Additionally, because it is a live connection to the database, 
updating the database will also update the query results. 
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7. Click the TEST button.  

This will show you what the table will look like. (You may need to scroll to the right to 
see all the fields.)  Please note that there is data from both cycles (1999, 2000) in the table. Also 
note that although this is a table of Category 5 causes, one of the AUs is listed as Fully 
Supporting. This is because the “Y” in the Threatened_ Flag field indicates it is Threatened, 
which puts it in Category 5. 

8. Close the table by clicking the X in upper right corner. 

 

9. Click the SAVE button. Save the query as IronFilter and click OK. 

 

10. From the Connections menu, choose View Saved SQL Scripts. (This table can be 
accessed this way at any point in the future.)  Double click on IronFilter. 

 

11. If you are using the MS Access version, the table you just created will open. Otherwise, 
enter ADBUSER (or the appropriate password) and click OK. 

 

12. The table you just created will open. Select one of the cells with Fish and Aquatic Life 
under the USE_DESC field. Right click on the cell and choose Filter. Only records with 
the Fish and Aquatic Life use should now be visible in the table. 
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13. Right-click on the same cell and choose Export Data. Choose the Export as Filtered 
option. 

 

14. Save the file in the “ADB_Sampledata” folder as Iron.txt. Click Save. In the “Text File 
Export Wizard” window, click Finish to create the text file. 

 

The text file you created above can be used to limit which AUs can be accessed in the 
main Assessment Units screen.  

15.  Close the Connections Module and return to the main Assessment Units screen in the 
ADBv2. (If the database is not already open, you can access it through the Start menu). 

 

16. In the “Select an Assessment Unit” section of the screen, choose Limit by Text File from 
the Limit List By: drop-down list. 

 

17. In the “Limit List by” dialog box, click the Choose New File button. Navigate to the 
Iron.txt file in your “ADB_Sampledata” folder and click Open. 

 

18. Pick ID305B from the Choose field to limit by drop-down list. This will relate the field 
that contains the ID in the Iron.txt table to the AU ID in the ADBv2. Click Finish. 

Note: The Limit by List function will only work with lists that have 1,000 IDs or less.  
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19. Under the “Select by Assessment Unit” dialog box, Click on the By ID: drop-down list. 
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You can see that of the records that were in the table, only two are present in this list. 
These are the two records associated with the 1999 cycle. 
 
20.  Close the Assessment Units screen. 

Summary 

In this exercise, you learned how to connect to an outside database and bring a table from 
that database into the ADBv2 and how to sort records in that table. You also learned how to 
perform a custom query within the connections module to answer a specific question. Finally, 
you learned how to export a newly created table from a query into a text file and, using the file, 
limit the records in the Assessment Units screen. 
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Exercise 6. Running the Data Validation Module 

In this exercise, you will learn about the features of the Data Validation Module and how 
to use it to check the data you have entered in the database for completeness. 

Overview 

The Data Validation Module serves two purposes:  

1. To ensure that all dates were entered properly 

2. To run any final validation checks on the data to ensure that all of the required 
data elements have been entered.  

1. Click on the Data Validation Module button at the top of the screen (below the menu 
toolbar):  
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Finalize Cycle 

When you finish a reporting cycle, the Finalize Cycle feature can help you make sure that 
your data has all of the necessary components. This feature creates log files of all the errors found 
during a data review check. The log files will be saved in .csv text file format, which can be 
opened with a number of different software programs, including MS Excel. These log files can 
be viewed by opening them in the “Finalize Cycle” dialog box. The log files will give you a 
listing of all of the AUs that may have problems that need to be fixed. 

1. In the main ADB Validation Checks screen, click the Finalize Cycle button.  

 

2. You are going to perform all of the validations, so select all of the boxes. 

 

All of the validation checks can be run individually or in combination with other validations.  

3. Click on the Begin Validation Checks button. 

 

4. You will be prompted to pick a place to store the log file that the Data Validation Module 
will create. Click OK, then navigate to your  ADB_sampledata directory and click Save. 

The Data Validation Module will start working. There is a status bar at the top of the 
screen that will indicate the progress of the check. Also, the text beside the check boxes will 
change as it completes these checks, indicating whether or not errors have been found. All of the 
validations indicate the checks are OK except for the TMDL Dates.  



ADBv2 Tutorial Exercise 6 – Running the Data Validation Module 

75 

 

5. Click on the Open Log button beside TMDL Dates found errors. The information that 
appears in the Potential Errors text box indicates that Lower Rocky River, Clifty Creek, 
and Oostanaula Creek are missing information.  

 

6. Highlight an AU ID in the Potential Errors box to get an error description.  
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According to the error, TMDL dates or priorities need to be added for both the chlorine 
and fecal coliform causes because they are pollutants that are impairing a designated use. You 
can add these dates and/or priorities with the Data Validation Module=s Check Dates feature. 

7.  Click CLOSE on the lower right corner of the dialog box. This will return you to the 
main “ADB Validation Checks” dialog box. 

Entering Dates with the Data Validation Module 

The Check Dates feature is provided to ensure that all dates associated with each 
assessment unit have been entered properly into the ADB. Both optional and required date entries 
may be checked in this module. Any missing dates may be entered through this screen, by an 
import/export of the list of dates, or by returning to the main ADB and individually entering the 
dates.  

1. Click on the Check Dates button in the main “ADB Validation Checks” dialog box. 

 

2. Under the “Select Which Dates to Work With” section, click the button for Scheduling 
of TMDL Dates/TMDL Priority.  

 

3. Under the “View Options” section, click on the Show Only IDs that require a date  
button. 



ADBv2 Tutorial Exercise 6 – Running the Data Validation Module 

77 

 

4. Select the first record in the table. Under Assigned Date, type “2002” and click the 
Update button. 

Notice that when you update a record, the record disappears from the table.  

Note:  Adding a TMDL schedule date does not change the category. 

5. Repeat the step for the next two records. 

It is understood that the person entering the assessment date in the ADB may not be the 
same person who determines the crucial dates (i.e., date scheduled to receive a TMDL) for the 
AUs. The Enter Dates feature in the Data Validation Module also allows you to export a list of 
all of the items requiring a date to a .csv file that can be opened using MS Excel. This file can be 
sent to the person responsible for these crucial dates, who can then fill in the dates and return the 
file to the person responsible for the ADB. You can then import this file to the Data Validation 
Module and all of the crucial dates will be updated according to the dates entered in the .csv file.  

6. Click CLOSE. This will return you to the main ADB Validation Checks screen. 

After you have resolved any issues discovered in the initial round of validation checks 
return to the Finalize Cycle screen to ensure that all the necessary components are now located 
in the database. 

7. Click the Finalize Cycle button. 
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8. Check only the box for Check TMDL Schedule Dates and click the Begin Validation 
Checks button. Save the log file in your “ADB_Sampledata” folder. 

The Data Validation Module indicates the TMDL dates are OK.  

9. Close the “Finalize Cycle” dialog box and exit the ADB Validation Checks screen. 

Summary 

In this exercise, you learned about the functionality of the Data Validation Module. You 
learned how to use the Finalize Cycle feature of the Data Validation Module to check the entries 
in the database for the presence of required information and you learned how to enter a required 
date using the Check Dates feature.  
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Exercise 7. Reports Module 

In this exercise, you will learn about the features of the Reports Module and how to use it 
to create and print out standardized reports. 

Overview 

The Reports Module can create summary reports for a selected state, water type, and 
cycle. It can also generate comprehensive reports for selected AUs.  

If you are not already logged in to the ADB, access the Reports Module by clicking on 
Start->Programs->ADBv2 for [version]->Reports. 

 

1. Click on the Reports Module button at the top of the main ADB screen. 

 



ADBv2 Tutorial Exercise 7 – Reports Module 

80 

Creating State Reports 

#State Reports were a new feature in the ADBv2.2. The following are the six reports that 
are available under this dialog: 

 Assessment Unit Summary List – This report has general information associated with 
the  assessment unit including, AU Name, Water Type, Water Size, Location 
Description, Use  and associated Attainments, Causes, Sources, and TMDL Status. 

 303(d) List Report – This report shows all waters on the 303(d) list with their 
associated causes, TMDL status, uses, and sources. 

 303(d) Delisting Report – Any delisting information entered into the ADB is 
available here. The 303(d) delisting report is a simple way to track the delisting status 
of all AUs in the database. 

 WQS Attainments Report – This report contains information for waters that have been 
removed from the list due to WQS attainment reasons. 

 TMDL Status Report – This report lists all of the AUs that require a TMDL and 
any information the user has entered regarding the progress towards submitting a 
TMDL. TMDL progress information can be entered through the TMDL information 
in the upper right corner of the Causes screen.  

 
 Atlas Report – This report contains a summary of the waterbody information entered 

under Atlas Information and is independent of AU information in the database. 

Feel free to open and explore the state reports. Reports will appear in a separate window. 
If you wish to save a report, go to File -> Save As in the toolbar of the report window and save 
the file as a text or .html where appropriate. When you are finished, close the report window and 
click Cancel on the AState Reports@ dialog box to return to the main Report Selection screen. 

Creating Summary Reports 

With the Reports Module, users can create use, cause, and source summaries for a 
selected state, cycle, and water type. Assessment data and 303(d) data dumps can also be 
performed through the Summary Report function. 

1. Click the Summary Reports button. 

This screen allows you to specify the type of report you want to create. The Current State 
and Current Cycle represent the state and cycle selected in the ADB. You can change these at 
any time by clicking on the Data menu. Summary Reports allow the user to: 

 Generate reports by state-specific water type or general EPA water type 
 Generate summaries based on uses, causes, or sources  
 Create data dumps 
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 Produce trophic status reports on all lakes 
 Produce summaries in waterbody quality trends.  

2.  Click the button beside EPA Water Type and select Stream/Creek/River. 
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3.  Make sure the box for Individual Use Support Summary is checked and click the 
Create New Report button. 

 
 

The report you have just created will appear in a separate window. This file will be 
available under Display Existing Report or can be found under C:\Program Files\ADB v.2\ 
Modules\XML_Report\report.html, but this file will be overwritten whenever another report 
query is performed. If you wish to save the file permanently, go to File -> Save As in the toolbar 
of the report window and save the report as a text or .html file where appropriate. 
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4.  Close the report window by clicking the X in the upper right corner. 

 

5.  Uncheck the box beside Individual Use Support and click the check box beside Cause 
Summary. When the Cause/Source Detail check box appears, click the Include Detail 
check box to remove the check. Click Create New Report. This will list summaries of 
pollutant groups and summaries of their specific components. 

 

6.  Close the report form by clicking on the X in the upper right corner after you have viewed 
the results. 

Other report summaries can be created in the same way. Feel free to explore the types and 
variations of summary reports by varying details, water types, and report combinations. 

Creating Data Dumps 

Data dumps for assessment data and 303(d) can be created by clicking one of the buttons 
at the bottom of the form. Both reports provide the same type of information; however, the 
303(d) data dump only lists AUs that are impaired.  

1. Under “Data Dump” section of the “Summary Report” dialog box, click the New button 
for “303(d) Data.” 

The .html report will open, and you can view assessment data. Notice that there are codes 
listed in the fields for designated use, causes, and sources. There is a legend feature in the data 
dump section that includes a look-up table for these codes.  

2. Close the table window and click the check box for Legend in the “Data Dump” section 
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of the “Summary Report” dialog box.  

 

3. Click the New button under “303(d) Data.”  A new report will be generated that lists the 
code for each field and their descriptions, as well as the 303(d) data that loaded initially.  

 

4. Close the report table form and click the Cancel button on the Summary Reports screen 
to return to the main reports dialog box. 

Creating AU Detail Reports 

The AU reports allow you to choose specific AUs based on various criteria and create 
custom reports on the selected AU(s). In this exercise, we will review the types of criteria 
combinations a user can use to create unique reports. 

1. Click AU Detail Reports button. 

The AU Detail Report screen will appear. You will notice that the button next to “All 
IDs” is the default selection option. Therefore, all AUs in the database appear in the list box in 
the lower portion of the screen. You can limit the AUs by choosing any of the other button 
selection options and entering additional filtering information as requested by the report module. 
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2. Under the “Selection Options” section, select the Choose by Cause button. 

 

3. The Choose IDs by Cause box will appear to the right. Make sure that the Specific Codes 
button is selected and choose Nitrogen, nitrite from the drop-down list. 

 

The AUs listed in the lower portion of the screen will be filtered to only include those 
AUs that have Nitrogen, nitrite as an associated cause.  

4. Choose TN06010102042_1000, Beaver Creek and TN06010201067, Third Creek from 
the list box by depressing the Control key while selecting the AUs. 

 

There are several ways to choose more than one AU. If you would like to select several 
consecutive AUs, you can press the Shift key while choosing the first and last AU you wish to 
include. To select all of the AUs, you can hold the Control key down and press A. You can also 
use the mouse to click and drag from the first AU you would like to select to the last consecutive 
AU you would like to select to highlight a list.  
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5. To limit or add assessment information to be included in the report, click the Options 
button. The checked boxes default to Assessment Type and Comments. 

 

6. Click the OK button to return to the AU Detail Report screen. 

 

7. Click the Report button to generate the detailed report for these two AUs. 

 

8. When you are finished viewing the report, close the report by clicking the X in the upper 
right corner and exit the reporting module. 

 

Creating Cycle Comparison Reports 

Cycle Comparison Reports is a new feature in the ADBv2.3.  This reporting feature 
allows you to select a range of information in which you can compare data from the current cycle 
to the previous cycle.  There are 5 available reports to choose from: 

 Summary Statistics – This report allows you to view the total number of assessment 
units in the current cycle compared to the previous cycle.  You can also compare the 
current cycle Assessment Unit – Cause Combinations and compare Water Sizes by 
Category for both the current and previous cycle. 

 
 Assessment Unit – Cause Combinations Added to List – This report contains any new 

assessment units and associated causes added to the 303(d) list for the current cycle. 
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 Changed Use Attainments – This report allows you to view current and previous 

assessment unit IDs, the associated uses and how the use attainments changed from 
the previous cycle to the current cycle. 

 
 Changed Category (Assessment Unit) – This report displays overall category changes 

for an assessment unit.  You can view the current assessment unit ID and overall 
category in comparison to the previous cycle assessment unit ID and overall category. 

 
 Waters Unaccounted For – This report contains information for waters and their 

associated causes that have been unaccountable removed from the 303(d) list without 
a valid delisting reason. 

 

Summary 

In this exercise, you learned how to create summary reports and comprehensive reports 
for AUs. You also learned how to perform a data dump for assessment data. 
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Exercise 8. Exploring the Probability Survey Module 

The Probability Survey Module is a new addition to the ADB and allows you to track 
probability-based survey information in the ADB database. This exercise will show you how to 
browse, add a new project, and create a project report in the Probability Survey Module.  

1.  Click the “Probability Survey Module” icon. 

 

 

2. Go to the Data drop-down menu and select Change State. Select OR in the Choose State 
drop-down menu and click OK. To change the Cycle, go to the Data drop-down menu 
and select Change Cycle. Select 2002 from the Choose Cycle Year drop-down menu and 
click OK.  

 

3. Click on the Browse button. The Browse screen in Probability Survey Module is similar 
to the main Browse feature. 
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4. Explore the different tabs on the Browse screen. When you are finished, click the 
CLOSE button. 

 

5. Click on the Results button. The Probability Survey Projects screen will open. 

 

This is the principal location to add probability monitoring data, view or update existing 
data, and create probability survey project reports. In the probability survey, a project is the 
unique unit with which all probability data is associated.  
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6. Click the ADD PROJECT button in the lower left side of the window. 

 

7. Enter the information as displayed below: 

 

 

8.  Click the ADD button. The “Project Details” window will appear. 

 

9.  Select the Geographic Information tab. In the “Assessed Water Size” dialog box, enter 
10. 
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10. Click the UPDATE button in the lower right corner of the screen. Feel free to explore the 
other tabs to familiarize yourself with the data fields available. 

Within the Project Details screen, geographic information system (GIS) coverages and 
documents may be added and geographic, statistical attainment, use, cause, and source 
information may be entered.   

11.  When you are finished exploring the “Project Details” window, click the CLOSE button 
to return to the Probability Survey Projects screen. 

You may view or update a project by highlighting the selected project and clicking the 
View Data button.  

12. Highlight the project we just added, P-1x, in the “Projects” dialog box.  

 

13. Click on the View Summary button to create a pie chart depicting the attainment 
percentages of P-1x. 
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14. Click CLOSE to return to the “Probability Survey Projects” window. 

 

You can save this chart as a .jpg image by clicking Save Chart. Navigate to the location 
you wish to save the chart and click Save in the “Choose Location” window. 

15. Highlight OR-NC_AVI in the “Probability Survey Projects” dialog box. 

 

16. Click the View Report button to create a summary report. The report is created in a 
separate window, identical to the Reports Module. 

 

17. Browse the report, then close the window by clicking the X in upper right corner to return 
to the “Probability Survey Projects” window. 

 

18. Close the “Probability Survey Projects” window, then exit the Probability Survey 
Module. 

Summary 

In this exercise, you learned how to add a project to the Probability Survey Module, view 
probability-based assessment data, and create reports and charts for Probability Survey projects. 

This concludes your tour of the ADBv2. For more information, visit the Internet at 
http://www.epa.gov/waters/adb. Support is also available by e-mailing attainshd-hq@epa.gov. 
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